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Introduction
The Quality Improvement Toolkit
This Quality Improvement (QI) Toolkit is made up of modules that are designed to support your practice to make
easy, measurable and sustainable improvements to provide best practice care for your patients. The Toolkit
will help your practice complete Quality Improvement (QI) activities using the Model for Improvement.
Throughout the modules you will be guided to explore your data to understand more about your patient
population and the pathways of care being provided in your practice. Reflections from the module activities and
the related data will inform improvement ideas for you to action using the Model for Improvement.
The Model for Improvement uses the Plan-Do-Study-Act (PDSA) cycle, a tried and tested approach to achieving
successful change. It offers the following benefits:
•

It is a simple approach that anyone can apply.

•

It reduces risk by starting small.

•

It can be used to help plan, develop and implement highly effective change.

The Model for Improvement helps you break down your change into manageable pieces, which are then tested
to ensure that the change results in measurable improvements, and that minimal effort is wasted.
There is an example of a ‘GP mental health treatment plan review for patients with anxiety’ using the Model for
Improvement and a blank template for you to complete at the end of this module.
If you would like additional support in relation to quality improvement in your practice please contact Brisbane
South PHN on optimalcare@bsphn.org.au
This icon indicates that the information relates to the ten Practice Incentive Program
(PIP) Quality Improvement (QI) measures.
Due to constant developments in research and health guidelines, the information in this document will need to
be updated regularly. Please contact Brisbane South PHN if you have any feedback regarding the content of this
document.
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Mental health – anxiety and depression
Mental health anxiety and depression toolkit for general practice
This toolkit is designed to assist you to review your patients who may be affected by anxiety or depression. Use
this toolkit in conjunction with the QI toolkit – Mental Health Introduction available from the Brisbane South
PHN website. It is suggested that you work through this toolkit and then identify the sub topic to focus on.
Key topics included in this toolkit are:
•

overview of anxiety & depression

•

understanding your patient anxiety and depression profiles

•

comparing your patient anxiety and depression profiles with other practices via Brisbane South PHN’s
benchmark report

•

data cleansing – ensuring the practice has consistent coding for patients with anxiety and depression

•

preventative health

•

Medicare item numbers for patients with anxiety and depression

•

referral pathways and support options via SpotOnHealth HealthPathways

•

resources.

Key goals/objectives for using this toolkit
This toolkit is to be used in general practice to:
•

develop a register of patients with anxiety and/or depression to facilitate better continuity of care
(reminders, recalls)

•

better manage the physical health of patients with anxiety and/or depression

•

improve medication management through review against clinical guidelines (e.g. appropriate use of
medications, risk management)

•

identify patients eligible for mental health and other funding streams.

Brisbane South PHN
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Activity 1 - Understanding your patient anxiety profile
What is an anxiety disorder?
Anxiety is a normal reaction to stress and can be beneficial in some situations. It can alert us to dangers and
help us prepare and pay attention. Anxiety disorders differ from normal feelings of nervousness or
anxiousness, and involve excessive fear or anxiety. 1
Anxiety becomes an anxiety disorder when it is more pervasive than usual and affects a person’s ability to
function day to day.
Anxiety is the most common mental health condition in Australia. Up to one-third of women and one-fifth of
men will experience anxiety at some point in their lives.
Anxiety disorders include a group of diagnoses including:
•

generalised anxiety disorder

•

social phobia

•

specific phobia

•

obsessive compulsive disorder

•

panic disorder with and without agoraphobia

•

separation anxiety disorder

•

post-traumatic stress disorder (this may also be considered separately as a trauma/stress related
disorder rather than an anxiety disorder).

Using CAT4 to identify patients with anxiety
You are able to search for patients with anxiety under conditions.

1

https://www.psychiatry.org/patients-families/anxiety-disorders/what-are-anxiety-disorders

Brisbane South PHN
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Identifying patients who may be eligible for a Mental Health treatment plan
The GP mental health treatment plan (MHTP) provides a structured framework for GPs to undertake early
intervention, assessment and management of patients with mental disorders, as well as providing referral
pathways to clinical psychologists and allied mental health service providers.
Please note: please select Anxiety under conditions.

Activity 1.1 – Data collection from CAT4
The aim of this activity is to collect data to identify patients with an anxiety disorder and assist with the
management of these patients
Complete the below table by collecting data from your CAT4 Data Extraction Tool.
Note - Instructions on how to extract the data is available from the CAT4 website. Number of patients with an
anxiety disorder or Number of patients who have had a mental health treatment plan completed in the past 12
months or Number of patients on medications or Number of patients with anxiety with risk factors
Total number of
active patients as
per RACGP criteria
(3 x visits in 2
years)

Description

1.1a

Number of active patient population

1.1b

Number of active patients (i.e.: 3 x visits in 2 years)

1.1c

Number of patients with an active anxiety disorder

1.1d

Number of patients aged <=15 years with an anxiety
disorder

1.1e

Number of patients aged between 16 years and 25
years with an anxiety disorder

1.1f

Number of patients aged between 26 years and 64
years with an anxiety disorder

1.1g

Number of patients aged >= 65 years with an anxiety
disorder

1.1h

Number of patients who identify as Aboriginal and
Torres Strait Islander with an anxiety disorder

1.1i

Number of patients with anxiety who have had a
mental health treatment plan completed in the past
12 months

1.1j

Number of patients with an anxiety disorder on
antidepressant medications

1.1k

Number of patients with an anxiety disorder on mood
stabilisers

Brisbane South PHN
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Description

Total number of
active patients as
per RACGP criteria
(3 x visits in 2
years)

1.1l

Number of patients with an anxiety disorder on
regular benzodiazepines

1.1m

Number of patients with an anxiety disorder who are
current smokers

1.1n

Number of patients with an anxiety disorder with
medication/substance abuse

1.1o

Number of patients with an anxiety disorder who are
classified as obese

Total number of
active patients

Please note: the RACGP defines active as 3 x visits in 2 years. This search criteria does not capture those
patients who may come in for screening every 2 years, or twice in 2 years e.g. flu vaccine, hence the option to
look at all active patients.

Reflection on Activity 1.1:

Practice name:

Date:

Team member:

Activity 1.2 – Reviewing your practice anxiety profile
Complete the checklist below to review your practice’s anxiety patients.

Description
After completing activity 1.1, are
there any unexpected results
with your practice’s anxiety
disorder profile?

Status
 Yes: see actions to be taken.

 No: continue with activity.

Action to be taken
Please explain: (e.g. lower number
of patients with anxiety disorder
than expected or a large number of
patients with anxiety disorder have
drug/alcohol abuse)

How will this information be
communicated to the practice
team?

Brisbane South PHN
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Description
After reviewing your practice’s
anxiety disorder profile, are there
any changes you would like to
implement in the practice to help
manage patients over the next 12
months?

Status

Action to be taken

 Yes: see actions to be taken.

 No: you have completed this activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.
Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.

Reflection on Activity 1.2:

Practice name:

Date:

Team member:

Activity 1.3 – Anxiety disorder measures on Benchmark report
The aim of this activity is to review your practice’s data dashboard on the monthly benchmark report
provided by Brisbane South PHN.
You will need your practice’s benchmark report to complete this information.

Description

Number

1.3a

Active population with coded mental health diagnosis

1.3b

Active patients with an anxiety disorder

Brisbane South PHN
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Reflection on Activity 1.3:

Practice name:

Date:

Team member:

Activity 1.4– Reviewing your practice anxiety condition profile on the
benchmark report
Complete the checklist below to review your practice’s anxiety condition profile from your benchmark
report.
Description
After completing activity 1.3, are
there any unexpected results
with your practice’s anxiety
condition profile?

Is your practice’s anxiety disorder
patient profile similar to other
practices in the Brisbane South
region (compare information
from Benchmark report)?

Status

Action to be taken

 Yes: see actions to be taken.

Please explain: (e.g. more than 80%
of our patients with a mental
health condition have an anxiety
disorder.)

 No: continue with activity.

How will this information be
communicated to the practice
team?

 Yes: continue with activity.

Outline the differences – (e.g. our
practice has a higher percentage
of patients with an anxiety
disorder than other practices.)

 No: see actions to be taken.
How will this information be
communicated to the practice
team?

Brisbane South PHN
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Description
After reviewing your practice’s
anxiety condition profile, are
there any changes you would like
to implement in the practice to
help manage patients over the
next 12 months?

Status

Action to be taken

 Yes: see actions to be taken.

 No: you have completed this activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.
Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.

Reflection on Activity 1.4:

Practice name:

Date:

Team member:

Brisbane South PHN
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Activity 2 - Understanding your patient depression profile
What is depression?
While we all feel sad, moody or low from time to time, some people experience these feelings intensely, for
long periods of time (weeks, months or even years) and sometimes without any apparent reason. Depression is
more than just a low mood – it's a serious condition that affects a person’s physical and mental health.2
Depression is often accompanied by a range of other physical and psychological symptoms that can interfere
with the way a person is able to function in their everyday life. The symptoms of depression generally react
positively to treatment.3

Using CAT4 to identify patients with depression
You are able to search for patients with depression under conditions.

Activity 2.1 – Data collection from CAT4
The aim of this activity is to collect data to identify patients with depression and assist with the
management of these patients
Complete the below table by collecting data from your CAT4 Data Extraction Tool.
Note - Instructions on how to extract the data is available from the CAT4 website. Number of patients with
depression or Number of patients who have had a mental health treatment plan completed in the past 12
months or Number of patients on medications or Number of patients with depression with risk factors
Description

2.1a

2
3

Total number of
active patients as
per RACGP criteria
(3 x visits in 2
years)

Total number of
active patients

Number of active patient population (from activity
1.1)

https://www.beyondblue.org.au/the-facts/depression
https://www.sane.org/information-stories/facts-and-guides/depression

Brisbane South PHN
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Description

Total number of
active patients as
per RACGP criteria
(3 x visits in 2
years)

2.1b

Number of active patients (i.e.: 3 x visits in 2 years)
(from activity 1.1)

2.1c

Number of patients with a current/active diagnosis of
depression

2.1d

Number of child & youth patients (aged 5 to 17 years)
with depression

2.1e

Number of older patients (aged >=65 years) with
depression

2.1f

Number of patients with post-natal depression in the
past 24 months

2.1g

Number of patients with depression who have had a
mental health treatment plan completed in the past
12 months

2.1h

Number of patients with depression on
antidepressant medications

2.1i

Number of patients with depression with
medication/substance abuse

2.1k

Number of patients with depression who are
classified as obese

Total number of
active patients

Please note: the RACGP defines active as 3 x visits in 2 years. This search criteria does not capture those
patients who may come in for screening every 2 years, or twice in 2 years e.g. flu vaccine, hence the option to
look at all active patients.

Reflection on Activity 2.1:

Practice name:

Date:

Team member:

Brisbane South PHN
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Activity 2.2 – Reviewing your practice depression profile
Complete the checklist below to review your practice’s depression patients.
Description
After completing activity 2.1, are
there any unexpected results
with your practice’s depression
profile?

Status

Action to be taken

 Yes: see actions to be taken.

Please explain: (e.g. lower number
of patients with depression than
expected or a large number of
patients with depression have
drug/alcohol abuse.)

 No: continue with activity.

How will this information be
communicated to the practice
team?

After reviewing your practice’s
depression profile, are there any
changes you would like to
implement in the practice to help
manage patients over the next 12
months?

 Yes: see actions to be taken.

 No: you have completed this activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.
Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.

Reflection on Activity 2.2:

Practice name:

Date:

Team member:

Brisbane South PHN
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Activity 2.3 – Depression measures on Benchmark report
The aim of this activity is to review your practice’s data dashboard on the monthly benchmark report
provided by Brisbane South PHN.
You will need your practice’s benchmark report to complete this information.

Description

Number

2.3a

Active population with coded mental health diagnosis

2.3b

Active patients with depression

Percentage

Reflection on Activity 2.3:

Practice name:

Date:

Team member:

Brisbane South PHN
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Activity 2.4– Reviewing your practice depression condition profile on the
benchmark report
Complete the checklist below which reviews your practice’s depression profile from your benchmark
report.
Description
After completing activity 2.3, are
there any unexpected results
with your practice’s depression
condition profile?

Status

Action to be taken

 Yes: see actions to be taken.

Please explain: (e.g. more than 60%
of our patients with a mental
health condition have depression.)

How will this information be
communicated to the practice
team?

 No: continue with activity.

Is your practice depression
patient profile similar to those at
other practices in the Brisbane
South region (compare
information from Benchmark
report)?

 Yes: continue with activity.

Outline the differences – (e.g. our
practice has a higher percentage
of patients with depression than
other practices.)

 No: see actions to be taken.
How will this information be
communicated to the practice
team?

After reviewing your practice’s
depression profile, are there any
changes you would like to
implement in the practice to help
manage patients over the next 12
months?

Brisbane South PHN

 Yes: see actions to be taken.

 No: you have completed this activity.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.
Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.
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Reflection on Activity 2.4:

Practice name:

Date:

Team member:

Brisbane South PHN
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Activity 3 – Building your practice anxiety and
depression condition register
Coding is simply a process of using an agreed standardised descriptor to store data as a series of numbers or
letters. There are multiple ways clinical staff may enter a patient’s diagnosis in practice software. Some will type
this information directly into the patient progress notes or enter the information as free text in the ‘reason for
encounter’ or ‘diagnosis field’. This process is called free texting or un-coded diagnosis. Free text is not easily
searchable in any database by the clinical software or third-party software (e.g. extraction tools).
The recommended process is to use a diagnosis from the drop-down boxes provided in the clinical software. This
is a coded diagnosis. If all clinical staff within the practice use the same codes to identify a diagnosis then it is
easier to search for particular conditions.
It is important to ensure your coding is consistent and agreed upon by all clinical staff in the practice, and
diagnostic criteria for anxiety are uniform. Listed below are the conditions that are used when conducting
searches in CAT4.

Data mapping anxiety and depression in CAT4 – Best Practice
When you select anxiety or depression under the conditions section in CAT4, the following diagnoses are
included in your results:
Depression
Anxiety

(Active only conditions are
collected)

•

Anxiety

•

Anxiety/Depression

•

Anxiety disorder

•

Depression

•

Anxiety neurosis

•

Depression, endogenous

•

Anxiety/Depression

•

Depression, Post Natal

•

Fear, irrational

•

Depression, reactive

•

GAD

•

Endogenous depression

•

Generalised Anxiety Disorder

•

Neurotic depression

•

Irrational fear

•

Organic depression

•

Neurotic depression

•

Post Natal Depression

•

Phobia

•

Reactive depression

•

Phobic anxiety disorder

•

Phobic disorder

•

Social Anxiety Disorder

•

Social phobia

More information about data mapping on CAT4 can be found here
Brisbane South PHN
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Data mapping anxiety and depression in CAT4 – Medical Director
When you select anxiety or depression under the conditions section in CAT4, the following diagnoses are
included in your results:
Depression
Anxiety

(Active only conditions are
collected)

•

Anxiety

•

Anxiety/Depression

•

Anxiety - Generalised

•

Depression - Endogenous

•

Anxiety - Social

•

Depression - Major

•

Anxiety disorder

•

Depression - Minor

•

Anxiety feeling

•

Depression - Post Natal

•

Anxiety neurosis

•

Depression - Reactive

•

Anxiety phobia

•

Depression - recurrent

•

Anxiety/Depression

•

Depressive anxiety disorder

•

Depressive anxiety disorder

•

Endogenous depression

•

Feeling anxious

•

Melancholia

•

GAD (Generalised Anxiety Disorder)

•

•

Generalised Anxiety Disorder (GAD)

Mixed anxiety/depressive
disorder

•

Mixed anxiety/depressive disorder

•

Organic depression

•

Mood - anxious

•

Post Natal Depression

•

Nervous

•

Reactive depression

•

Nervous Anxiety

•

Neurotic anxiety

•

Phobia

•

Social Anxiety Disorder

•

Social Phobia

•

Tense

More information about data mapping on CAT4 can be found here

Brisbane South PHN
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Activity 3.1 – Determine terms of consistent coding
The aim of this activity is for the clinical team to agree on consistent coding to be used within the
practice for anxiety and depression disorders.
Description

Status

Action to be taken

Are relevant practice team
members aware of the
importance of quality data
including using consistent coding
(avoiding free text)?

 Yes: continue with this activity.

Organise a practice team meeting to
discuss how to develop a clinical
coding policy for your practice for
anxiety disorders.

Have you agreed on accepted
terminology of anxiety disorder
conditions from the drop-down
lists in your practice software?

 Yes: continue with this activity.

Source list of clinical codes already
available in current clinical software.

 No, see action to be taken.

Source list of clinical codes from
CAT4 clinical audit tool.

 No, see action to be taken.

From these two lists agree on clinical
codes for anxiety disorder to be used
within practice.
_____________________________
_____________________________
_____________________________
_____________________________
Have you agreed on accepted
terminology of depression from
the drop-down lists in your
practice software?

 Yes: continue with this activity.

Source list of clinical codes already
available in current clinical software.

 No, see action to be taken.

Source list of clinical codes from
CAT4 clinical audit tool.

From these two lists agree on clinical
codes for depression disorder to be
used within practice.
_____________________________
_____________________________
_____________________________

Brisbane South PHN
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Description
Are practice team members
aware of how to enter diagnosis
in clinical software using agreed
conditions?

Status

Action to be taken
See instructions for Best practice
users.

 Yes: continue with this activity.

 No, see action to be taken.
See instructions for Medical Director
users.
After reviewing your practice’s
clinical coding guidelines for
anxiety and depressive
disorders, are there any changes
you would like to implement in
the practice, to help manage
patients, over the next 12
months?

 Yes, see actions to be taken to help
set your goals.

 No, you have completed this
activity.

Refer to the Model for Improvement
(MFI) and the Thinking part at the
end of this document.
Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to test
and measure your ideas for success.

Reflection on Activity 3.1:

Practice name:

Date:

Team member:

Brisbane South PHN
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Activity 3.2 – Cleaning up un-coded conditions in your practice software
You can clean up un-coded conditions that have been recorded in your practice software. Cleaning up uncoded items makes it easier to perform database searches and manage third-party clinical audit tools.
Instructions for cleaning up un-coded conditions in Best Practice
It is also possible to clean up un-coded
conditions the have been recorded in the Past
History section of Best Practice. This can assist
when performing database searches or using
3rd party Clinical Audit tools.
This clean up is done via the BP Utilities
function. Select Start > Programs > Best
Practice Software > Best Practice > BP
Utilities. Select your user name from the dropdown list. You will only have access to this
function if you have sufficient user
permissions.

Double click on the
icon. The Past History
cleanup screen will appear.
Un-coded Past History is a
current list of all past history
entries entered into the
database (usually from a
conversion or free texted),
and the Conditions column is
the complete list of coded
conditions entered into Best
Practice.
On the left-hand side,
highlight the item that will be
merged to a coded condition.
On the right-hand side, enter
the coded condition into the
keyword search field.
Highlight the condition to
merge to, then select replace
button.

Brisbane South PHN

23

MENTAL HEALTH ANXIETY TOOLKIT

QUALITY IMPROVEMENT TOOLKIT
Instructions for cleaning up un-coded conditions in Medical Director
Medical Director provides a simple utility in HCN Maintenance that enables you to easily find un-coded Past
Medical History items, and either link them to a coded item or replace them with the correct coded item.
1.
2.

Double click the HCN Maintenance icon
to open HCN Maintenance.
Select Medical Director Clinical in the list of Database Tasks on the left of the window.

3.

Double click the Diagnosis Coder icon

The left-hand panel of this screen contains all the un-coded diagnosis entries in the Past Medical History
database. The right-hand panel displays coded entries that you will select from to pair with your un-coded
entries. Note that the right-hand panel is initially empty, but as you type into the text box above it, a list of
items is generated underneath.
Simply highlight the entry on the left and the one you want to link it to or replace it with on the right, and then
click either the Link or Correct button.
The link button will attach the code for that diagnosis to the coded entry on the right. The correct button will
change the diagnosis on the left to that on the right (i.e. if the word was misspelled).

Reflection on Activity 2.2:

Practice name:

Date:

Team member:
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Activity 4. Preventative health for people with anxiety or
depression
Looking after physical health is important for everyone, but it can be an extra challenge for people who have
anxiety and/or depression.
This may be related to the symptoms of the illness or the side-effects of medication. It may be due to smoking,
not getting enough exercise, or other lifestyle factors. Physical health problems can also be overlooked when
everyone’s focus is on looking after the anxiety or depression disorder.
Whatever the reasons, people affected by mental illness often have some of the following problems:
•

weight gain

•

high blood pressure

•

high cholesterol

•

high blood glucose levels.

These problems may lead to heart disease, diabetes or other illnesses.
The aim of this activity is to look at preventative health options for patients with an anxiety or depression. This
will focus on:
•

physical activity

•

alcohol

•

smoking

•

weight & BMI

•

other risk factors, including blood pressure, BSL and cholesterol.

Mental health disorders and cancer screening
People with mental health disorders are also potentially less likely to participate in cancer screening. Brisbane
South PHN has a cancer screening toolkit to assist with identifying under-screened patients.

Mental health disorders and older people
Mental health conditions are common throughout the Australian population, and older people are more likely
to experience contributing factors such as physical illness or personal loss.
It is thought that between ten and fifteen per cent of older people experience depression and about ten per
cent experience anxiety.4
Brisbane South PHN has a QI toolkit for older people.

4

https://www.beyondblue.org.au/who-does-it-affect/older-people
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Physical activity
As defined in the most recent RACGP report supporting Australia’s physical activity and sedentary guidelines
for adults, six terms apply to this section:
•

physical activity

•

sedentary behaviours

•

metabolic equivalent (MET)

•

intensity

•

frequency

•

duration.

Physical activity is important for mental health, pain management, a range of chronic diseases, disease
prevention and health promotion. There is evidence that exercise can be an important part of treatment for
anxiety and depression. 5

Activity 4.1 – Data Collection from CAT4
Complete the below table by collecting data from your Practice Monthly Benchmark Report.
The aim of this activity is to collect data to determine the number of patients with their physical activity
recorded.
Description

Total
Number

4.1a

Number of active patients (3x visits in 2 years)
(from activity 1.1)

4.1b

Number of active patients who have their
physical activity recorded

4.1c

Number of active patients with a mental health
condition who have their physical activity
recorded

%
completed

Accreditation
target met

□ Yes □ No

Please note: As a general rule, data recording in this area is low across all practices in the Brisbane South PHN
area. If the option for data recording is not user friendly at your practice, please notify your software provider.

Reflection on Activity 4.1:

Practice name:

Date:

Team member:

5

https://www.sciencedirect.com/science/article/abs/pii/S016517811630909X
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Figure: Sample snapshot of Brisbane South PHN benchmark report – mental health - management

Smoking and alcohol status
In Australia, while the prevalence of smoking is declining in the general community, it remains high among
people with mental illness. Compared with the general population, people with mental illness have higher
smoking rates, higher levels of nicotine dependence, and a disproportionate health and financial burden from
smoking.6 Anxiety disorders may also be linked with increased smoking of cannabis. This may be used as a
form of self-medication but is also linked with long-term worsening of anxiety.7
Alcohol is often used by people with anxiety as a coping mechanism. This can lead to alcohol dependence and
withdrawal, and can cause dangerous interactions with other medications. Alcohol can alter:
•

mood

•

energy levels

•

sleeping patterns

•

concentration

•

memory

•

risk of injury.

Alcohol also reduces inhibitions and impacts decision making. 8

6

https://www.tobaccoinaustralia.org.au/chapter-7-cessation/7-12-smoking-and-mental-health
https://www.jwatch.org/na46954/2018/06/22/cannabis-worsens-mood-and-anxiety-disorders-long-run
8
https://headspace.org.au/young-people/how-does-alcohol-affect-mental-health/
7

Brisbane South PHN

27

MENTAL HEALTH ANXIETY TOOLKIT

QUALITY IMPROVEMENT TOOLKIT

Activity 4.2 – Data Collection from CAT4
Complete the below table by collecting data from your PIP QI measures from your practice monthly
Benchmark Report. You can also collect information from CAT4. The recipe is available here (change
condition to anxiety or depression)

The aim of this activity is to collect data to determine the number of patients who have their smoking and
alcohol status recorded.
Description

Percentage

4.2a

Number of active patients aged 15+ years with
smoking status recorded as current smoker

4.2b

Number of active patients aged 15+ years with an
alcohol consumption status recorded

4.2c

Number of active patients with a mental health condition
who are current smokers

4.2d

Number of active patients with a mental health condition
who drink alcohol

Number

Please note: not all patients included in the PIP QI reports will have an anxiety disorder. You can produce reports
from CAT4 to just include anxiety disorder patients.
Reflection on Activity 4.2:

Practice name:

Date:

Team member:

Brisbane South PHN

28

MENTAL HEALTH ANXIETY TOOLKIT

QUALITY IMPROVEMENT TOOLKIT

Weight, BMI and cholesterol
Sometimes, people feel down or anxious about their weight. They may feel guilty for not being healthy and
energetic. They may blame themselves for not being fit and active. As well, if a person has depression or
anxiety their appetite, energy levels, self-esteem and weight can all be affected.9

Links between mental health and heart disease
Heart conditions such as heart attack and angina often occur with anxiety. Anxiety and depression are
considerable risk factors for coronary heart disease, along with smoking, high cholesterol and high blood
pressure.
•

Anxiety and depression are a significant risk factor for heart disease.

•

Anxiety and depression are linked with conventional risk factors for heart disease (such as an unhealthy
lifestyle).

•

Anxiety and depression are common among people with heart disease. It affects recovery and
increases the risk of further heart incidents. Heart attack patients with anxiety or depression are often
less motivated to follow healthy daily routines, which means they may skip important medication,
avoid exercise and proper diet, and continue harmful behaviours such as smoking and drinking
alcohol.10

Cardiovascular risk calculator
The Australian Absolute cardiovascular disease risk calculator has been produced by the National Vascular
Disease Prevention Alliance for the information of health professionals. To use the calculator, you will need a
patient’s age, blood pressure, smoking status, total and hdl cholesterol and ECG LVH if known. This calculator
can be accessed at http://www.cvdcheck.org.au/ . It is also included in Best Practice and Medical Director.

Activity 4.3 – Data Collection from CAT4
Complete the below table by collecting data from your PIP QI measures from your practice monthly
Benchmark Report or via CAT4 search.

The aim of this activity is to collect data to determine the number of patients with their BMI recorded as
overweight or obese and also to monitor cholesterol levels
Description
4.3a

Percentage

Number of active patients aged 15+ years with an anxiety
disorder who have a BMI recorded as ‘overweight’ in the
previous 12 months

9

http://healthyweight.health.gov.au/wps/portal/Home/keep-in-check/managing%20the%20challenges/mental-healthand-weight/!ut/p/a0/04_Sj9CPykssy0xPLMnMz0vMAfGjzOI9jFxdDY1MDD3dzbycDTzNLfwsfP0MjYJNTfULsh0VAUgJjsw!/
10
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC5149447/
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Description

Percentage

4.3b

Number of active patients aged 15+ years with an anxiety
disorder who have a BMI recorded as ‘obese’ in the previous
12 months

4.3c

Number of active patients aged 15+ years with depression who
have a BMI recorded as ‘overweight’ in the previous 12
months

4.3d

Number of active patients aged 15+ years with depression who
have a BMI recorded as ‘obese’ in the previous 12 months

4.3e

Number of active patients with an anxiety disorder with a total
cholesterol result > 7.5

Reflection on Activity 4.3:

Practice name:

Date:

Team member:

Activity 4.4 – Understanding your practice preventative health activities
The aim of this activity is to increase your understanding of preventative health activities for your
patients with an anxiety disorder.
Description

Status

Action to be Taken

After completing activity 4.1, are
there any unexpected results with
your practice’s patient physical
activity status?

 Yes: see actions to be taken.

Please explain: (e.g. low recording
of physical activity status.)

 No: continue with activity.

How will this information be
communicated to the practice
team?
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Description

Status

Action to be Taken

After completing activity 4.2, are
there any unexpected results with
your practice’s patient alcohol and
smoking status?

 Yes: see actions to be taken.

Please explain: (e.g. high number of
patients with an anxiety disorder
who drink alcohol.)

 No: continue with activity.

How will this information be
communicated to the practice
team?

After completing activity 4.3, are
there any unexpected results with
your practice’s patient weight,
BMI and cholesterol status?

 Yes: see actions to be taken.
 No: continue with activity.

Please explain: (e.g. high number of
patients with an anxiety disorder
who are obese.)

How will this information be
communicated to the practice
team?

Are your practice patient
measures similar to other
practices in the Brisbane South
region (compare information from
Benchmark report)?

 Yes: continue with activity.

Outline the differences – (e.g.:
we’re on par with other practices,
others are doing much better than
us.)

 No: see action to be taken.

How will this information be
communicated to the practice
team?

Do all relevant team members
know how to enter physical
activity status in your practice’s
clinical software?

Brisbane South PHN
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Description

Status

Action to be Taken

Do all relevant team members
know how to enter alcohol and
smoking status in your practice’s
clinical software?

 Yes: continue with activity.

Do all relevant team members
know how to use the
cardiovascular risk calculator in
your practice’s clinical software?

 Yes: continue with activity.

Are all the measures being
recorded in the correct fields in
your clinical software? (e.g.: BP,
BMI, waist circumference etc.,)

 Yes: you have completed this
activity.

Review how and where your risk
factor information is being recorded
in your practice software.

 No, see action to be taken.

See instructions on entering
information in Best Practice.

See instructions on how to enter
into Best Practice or Medical
Director.

 No: see action to be taken.

See instructions on how to enter
into Best Practice or Medical
Director.

 No: see action to be taken.

See instructions on entering
information in Medical Director.

Ensure all relevant team members
are aware of how to record risk
factor information.
Document in practice policy.
After reviewing practice physical
activity, smoking, alcohol, weight,
BMI and cholesterol status, are
there any changes you would like
to implement in the practice to
help using practice software, over
the next 12 months?

 Yes, see actions to be taken
to help set you goals.

Refer to the Model for
Improvement (MFI) and the
Thinking part at the end of this
document.

 No, you have completed this
activity.

Refer to the Doing part - PDSA of
the Model for Improvement (MFI)
to test and measure your ideas for
success.

Reflection on Activity 4.4:

Practice name:

Date:

Team member:
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Entering physical activity information in the patient file in Best Practice
1. Open the patient file.
2. Select ‘Clinical’ and ‘Physical Activity Prescription’.

3. Complete the physical activity by using the dropdown menu options.
4. Click ‘Print’ to save.

Entering physical activity information in the
patient file in Medical Director
1. Open the patient file.
2. Click on the ‘Physical Activity Prescription’ (red person running) on the toolbar.

3. You can then complete an assessment or prescribe the patient a physical activity.

Brisbane South PHN
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Instructions for entering alcohol and smoking status in Best Practice
1. While the patient file is open, select Open Alcohol & Smoking history.

2. Select Tobacco on the left-hand side menu.
3. Once you have entered the information, select Alcohol.
4. Select Save to complete.

Instructions on entering alcohol and smoking status into Medical Director
1. Have the patient file open.

2.

From the ‘Patient’ menu select ‘Details’.

3. This will then open up a screen where you can enter patient details, allergy/reactions, family/social
history, smoking, alcohol and personal details.
Brisbane South PHN
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4. Select Smoking.

5. Once you have entered the details, select Alcohol.
6. Once all details have been completed, select Save.

Instructions on entering measurements into Best Practice
1. Have the patient’s file open.
2. From the top menu, select Clinical > Observations.

3. Enter the appropriate information.

4. Click Save to complete.
Brisbane South PHN
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Instructions on entering measurements into Medical Director
1. Have the patient’s file open.
2. From the top menu select Tools > Tool Box > Tool Box.

3. Select the appropriate tab and enter the relevant information.

4. Click Save to complete.

Best Practice Cardiovascular Risk Calculator
1. Open patient file.

Brisbane South PHN
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2. Select Clincial > Cardiovascular Risk.
3. The Cardiovascular risk screen will open.

4. Enter patient results in the appropriate box. After all the details have been entered a score will appear.
5. Click Save for this to be recorded in patients file.

Medical Director Cardiovascular Risk Calculator
1. Open patient file.
2.

Select Tools > Tool Box > Cardiovascular Risk.

3. The Cardiovascular Risk Calculator screen will appear.

Brisbane South PHN
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4. Enter the patient results in the appropriate boxes. The result will appear on the calculator guide.

5. Click save and this result will be saved in the patient’s file.
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Activity 5. Medicare item numbers for patients with
anxiety or depression
Patients with an anxiety and or depression disorder may be eligible to access item numbers within the
Medicare Benefit Schedule (MBS). These are dependent on patient age, ethnicity and co-morbidities.
Conditions apply to each item number; please ensure the GP understands these prior to claiming the item
number/s. Brisbane South PHN has a comprehensive toolkit looking at MBS items. Item numbers include:

Better access to psychiatrists, psychologists and general practitioners through
the MBS (Better Access) initiative
The purpose of the Better Access initiative is to improve treatment and management of mental illness within
the community. The Better Access initiative is increasing community access to mental health professionals and
team-based mental health care, with general practitioners encouraged to work more closely and
collaboratively with psychiatrists, clinical psychologists, registered psychologists and appropriately trained
social workers and occupational therapists. Part of the Better Access funding has been allocated to education
and training for health professionals.
More information about the initiative can be found here

Mental health consultation (item 2713)
The GP mental health treatment consultation item is for an extended consultation with a patient where the
primary treating problem is related to a mental disorder, including for a patient being managed under a GP
Mental Health Treatment Plan. This item may be used for ongoing management of a patient with a mental
health disorder. This item should not be used for the development of a GP Mental Health Treatment Plan.
A GP mental health treatment consultation must include:
•

taking relevant history and identifying the patient's presenting problem(s) (if not previously
documented)

•

providing treatment, advice and/or referral for other services or treatment

•

documenting the outcomes of the consultation in the patient's medical records and other relevant
mental health plan (where applicable).

Consultations associated with this item must be at least 20 minutes duration.
There are no limits to the amount of times this item number can be claimed.
More information can be found on MBS Online.

Brisbane South PHN
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Mental health treatment plan (MBS item 2700, 2701, 2715 or 2717)
GPs providing mental health treatment plans, who have undertaken mental health skills training recognised
through the General Practice Mental Health Standards Collaboration, have access to items 2715 and 2717.

Item Description
Mental health plan MBS Items
2700, 2701, 2715 or 2717)

Medicare Criteria

Frequency of claiming

A mental health disorder is a term
used to describe a range of
clinically diagnosable disorders
that significantly interfere with an
individual's cognitive, emotional
or social abilities.
The mental health plan must
include:
•
documenting the results
of assessment, patient
needs, goals and actions,
referrals and required
treatment/services
•
review date in the
patient's GP mental health
treatment plan

A new plan may be completed
after 12 months if clinically
required and if the person meets
the eligibility criteria.
After the plan has been
completed, the patient is entitled
to up to 10 Medicare-subsidised
visits (6 visits initially, another 4
after a review) with a psychologist
per calendar year.

More information is available in the Education guide for mental health care

Mental health treatment plan review (MBS item 2712)
The review item is a key component for assessing and managing the patient's progress once a GP mental health
treatment plan has been prepared, along with ongoing management through the GP mental health treatment
consultation item and/or standard consultation items. A patient's GP mental health treatment plan should be
reviewed at least once.
A rebate can be claimed once the GP who prepared the patient's GP mental health treatment plan (or another
GP in the same practice or in another practice if the patient has changed practices) has undertaken a
systematic review of the patient's progress against the GP mental health treatment plan.
The review must include:
•

recording the patient's agreement for this service

•

a review of the patient's progress against the goals outlined in the GP mental health treatment plan

•

modification of the documented GP mental health treatment plan if required

•

checking, reinforcing and expanding education

•

a plan for crisis intervention and/or for relapse prevention, if appropriate and if not previously
provided

•

re-administration of the outcome measurement tool used in the assessment stage, except where
considered clinically inappropriate.

A mental health plan review can be claimed every 3 months or at least 4 weeks after claiming the mental
health plan item number.
Brisbane South PHN
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Activity 5.1 – Data collection from CAT4
Complete the below table by collecting data from the CAT4 data instruction tool. Instructions are
available for identifying patients eligible for a mental health treatment plan OR identifying patients
eligible for a mental health treatment plan review (select anxiety only under mental health conditions,
then click recalculate and select depression)
The aim of this activity is to collect data to determine the number of patients with an anxiety disorder and
depression who may be eligible for a mental health treatment plan or review
Description

Total number of
active patients as
per RACGP criteria
(3 x visits in 2
years)

5.1a

Number of patients with an anxiety disorder (from
activity 1.1)

5.1b

Number of patients with anxiety who have had a
mental health treatment plan completed in the past
12 months (from activity 1.1)

5.1c

Number of patients with anxiety who may be eligible
for a mental health treatment plan

5.1d

Number of patients with anxiety who may be eligible
for a mental health treatment plan review

5.1e

Number of patients with depression (from activity
2.1)

5.1f

Number of patients with depression who have had a
mental health treatment plan completed in the past
12 months (from activity 2.1)

5.1g

Number of patients with depression who may be
eligible for a mental health treatment plan

5.1h

Number of patients with depression who may be
eligible for a mental health treatment plan review

Total number of
active patients

Reflection on Activity 5.1:

Practice name:

Date:

Team member:
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Activity 5.2 – Checklist for reflection on MBS claiming
Complete the checklist below to review your practice’s MBS claiming for patients with an anxiety
and/or depression disorder.

Questions to consider

Status

Action to be Taken

After completing activity 5.1, are
there any unexpected results with
your practice’s claiming for mental
health patients?

 Yes: see actions to be taken

Please explain: (e.g. low % of
patients with a MH treatment plan
or we are doing well at claiming
MH treatment plan reviews)

 No: continue with activity

How will this information be
communicated to the practice
team?

Are there any patients with an
anxiety disorder without a mental
health treatment plan completed
in the past 12 months? (refer to
MBS criteria

 Yes, see action to be taken.

Please explain.

 No, continue with the
activity.

What action will you take?

Are there any patients with
depression without a mental
health treatment plan completed
in the past 12 months? (refer to
MBS criteria)

 Yes, see action to be taken.

Please explain.

 No, continue with the
activity.

What action will you take?

Brisbane South PHN
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Questions to consider
Do relevant staff know where to
find appropriate templates for
mental health treatment plans?

Status

Action to be Taken

 Yes, continue with the
activity.

See templates available here for
Best Practice and Medical Director.

 No, see actions to be taken.


Do relevant staff know what the
criteria is for completing mental
health treatment plans and
reviews?

 Yes, continue with the
activity.

 No, see actions to be taken.

Mental health treatment plan
reviews

Do relevant team members know
how to use the MBS items app on
TopBar?

 Yes: continue with activity.

Refer to the instructions on the
MBS app.

Refer to MBS criteria at:
Mental Health treatment plans

 No: see actions to be taken.
Contact the Digital Health team at
Brisbane South PHN on
ehealth@bsphn.org.au if your team
requires additional training.

Do you know the contact details
for any MBS related questions?

 Yes, continue with the
activity.

Email: askMBS@health.gov.au
Provider enquiry line - 13 21 50

 No, see actions to be taken.

After reviewing the MBS claiming
for patients with an anxiety
and/or depression disorder, are
there any changes you would like
to implement in the practice to
help manage patients over the
next 12 months?

Brisbane South PHN

 Yes, see actions to be taken.

 No, you have completed this
activity.
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Reflection on Activity 5.2:

Practice name:

Date:

Team member:

Instructions for completing mental health treatment plan in Best Practice
1. Open the patient file.

2. Select Correspondence out.
3. Select Add > New document.
4. Identify and select the appropriate mental health treatment plan.

5. Complete the plan, then Save to complete.
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Instructions for completing mental health treatment plan in Medical Director
1. Open the patient file
2. Select Letters from the menu bar

3. Select + to start a new template.
4. Then click File > New.
5. Select GP Mental Health Treatment Plan (either Adult or child).
6. Complete the plan, then Save to complete.
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Activity 6. SpotOnHealth HealthPathways - anxiety and
depression
SpotOnHealth HealthPathways provides clinicians in the greater Brisbane south catchment with web-based
information outlining the assessment, management and referral of more than 550 conditions.
SpotOnHealth HealthPathways boasts a range of benefits including:
•

best available information on how to assess and manage common clinical conditions, including when
and where to refer patients

•

easy online access to clinical and patient resources for in-consult use, peer-reviewed and localised to
our region

•

integrated, concise, and saving you time.

It is an initiative of Metro South Health and Brisbane South PHN, in partnership with Mater Health Services and
Children's Health Queensland. For more information, visit the SpotOnHealth HealthPathways project site
It is designed to be used at point of care primarily by general practitioners but is also available to specialists,
nurses, allied health and other health professionals.
To access these resources, you will need to login.

SpotOnHealth HealthPathways and Topbar
The Topbar app provides a simple one-click access to the HealthPathways website. Topbar will show the app
name (default is HealthPathWays) on top of your screen

SpotOnHealth HealthPathways and anxiety
SpotOnHealth HealthPathways is a useful tool for accessing information to assist with managing your patients
with anxiety and/or depression.
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You can search for a particular topic in the top left corner and under each topic there is a range of information
available that may include:
•

information specific to Aboriginal & Torres Strait Islander people

•

information specific to culturally and linguistically diverse communities

•

assessment tools and pathways

•

management steps according to the latest guidelines

•

requests/referral pathways

•

clinical Resources

•

patient Information

•

references.

Activity 6.1 – Checklist for reflection on use of SpotOnHealth HealthPathways
Complete the checklist below to review your practice’s use of SpotOnHealth HealthPathways
Questions to consider
Do all GPs and Nurses have
login details for SpotOnHealth
HealthPathways?

Status

Action to be taken

 Yes, continue with the
activity.

To obtain username and password email
spotonhealth@health.qld.gov.au

 No, see actions to be
taken.
Do all GPs and Nurses know
how to access SpotOnHealth
HealthPathways via Topbar?

 Yes, continue with the
activity.

After reviewing the practice
usage of SpotOnHealth
HealthPathways, are there any
changes you would like to
implement in the practice to
help manage patients over the
next 12 months?

 Yes, see actions to be
taken.

Contact BSPHN Digital Health Team via
email: ehealth@bsphn.org.au

 No, see actions to be
taken.

 No, you have completed
this activity.

Refer to the Model for Improvement
(MFI) and the Thinking part at the end of
this document.
Refer to the Doing part - PDSA of the
Model for Improvement (MFI) to test and
measure your ideas for success.

Reflection on Activity 6.1:

Practice name:

Date:

Team member:
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Activity 7. Resources and education
Resources for health professionals
•

Mental health guidelines – RACGP

•

NICE Clinical Guidelines –Generalised Anxiety Disorder and Panic Disorder in Adults

•

Psychiatryonline –Quick reference for anxiety disorders

•

Queensland Health:
o

Clinical Guidelines: Mental Health Act 2016

o

Examinations and Assessments

o

Mental health forms

•

Keeping body and mind together – RANZCP

•

Clinical Guidelines for the Physical Care of Mental Health Consumers

•

Headspace clinical toolkit

•

Diagnostic and Statistical Manual of Mental Disorders, 5th edition – American Psychiatric association

•

SpotOnHealth HealthPathways

Education for health professionals
•

Mental health skills training – ThinkGP

•

Black Dog Institute –Managing anxiety online webinar and Anxiety and e-Mental Health factsheet

•

BMJ learning module – Generalized anxiety disorder: diagnosis and treatment - requires registration

•

Insight training

•

Mental health CPD for nurses

•

RACGP e-learning modules

•

Brisbane South PHN Education events

•

National Prescribing Service - You can find a number of resources focused on mental health conditions.
Specific resources of interest to health professionals may include:
o

MedicineWise News

o Clinical eAudit
o

Online case study

Resources for patients
•

Beyond Blue

•

Blackdog Institute –Mindfulness

•

CALM - Computer Assisted Learning for the Mind

•

Centre for Clinical Interventions –Progressive muscle relaxation

•

E-couch

Brisbane South PHN
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•

Emergency Crisis Contact Numbers

•

Mental Health Online

•

NPS Medicinewise –Antidepressant medications explained

•

Reconnexion

•

This Way Up

•

YourHealthinMind –About Depression

Resources for Aboriginal and Torres Strait Islander patients
•

Family support and healing -Queensland health

•

Beyond Blue

•

Head to health

Brisbane South PHN
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Quality improvement activities using The Model for
Improvement and PDSA
After completing any of the workbook activities above, you may identify areas for improvement in the
management of patients with anxiety and/or depression. Follow these steps to conduct a Quality Improvement
Activity using The Model for Improvement and PDSA. The model consists of two parts that are of equal
importance.
Step 1: The ‘thinking’ part consists of three fundamental questions that are essential for guiding improvement
work:
• What are we trying to accomplish?
• How will we know that the proposed change will be an improvement?
• What changes can we make that will lead to an improvement?
Step 2: The ‘doing’ part is made up of Plan, Do, Study, Act (PDSA) cycles that will help to bring about rapid
change:
• Helping you test the ideas.
• Helping you assess whether you are achieving your desired objectives.
• Enabling you to confirm which changes you want to adopt permanently.

Brisbane South PHN
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Model for Improvement and PDSA worksheet EXAMPLE
Step 1: The Thinking Part - the 3 Fundamental Questions
Practice name:
Date:
Team member:
Q1. What are we trying to accomplish?
(Goal)
By answering this question, you will develop your goal for improvement
Our goal is to:
• Ensure all patients with an anxiety disorder have their GP mental health plan reviewed.
This is a good start, but how will you measure whether you have achieved this goal? The team will be
more likely to embrace change if the goal is more specific and has a time limit.
So, for this example, a better goal statement would be:
Our S.M.A.R.T. goal is to:
• Increase the percentage of people with anxiety who have had a review of the GP mental health plan
completed in the past 12 months by 10% by 31 July.
Q2. How will you know that a change is an improvement?
(Measure)
By answering this question, you will develop MEASURES to track the achievement of your goal.
E.g. Track baseline measurement and compare results at the end of the improvement.
We will measure the percentage of active patients with anxiety who have a GP mental health treatment plan
to ensure they have a review completed. To do this we will:
A) Identify the number of active patients with an anxiety disorder who have a GP mental health plan
B) Identify the number of active patients with an anxiety disorder who have had their GP mental
health treatment plan reviewed
B divided by A x 100 produces the percentage of patients who have had their mental health plan reviewed.
Q3. What changes could we make that will lead to an improvement?
(List your IDEAS)
By answering this question, you will develop the IDEAS that you can test to achieve your CHANGE goal.
You may wish to BRAINSTORM ideas with members of our Practice Team.
Our ideas for change:
1. Using CAT4, identify active patients with an anxiety disorder who have not had a GP mental health
treatment plan completed in the past 12 months
2. Identify patients from list exported from CAT4 and create a TopBar prompt
3. Source and provide endorsed patient education resources (in waiting rooms, etc)
The team selects one idea to begin testing with a PDSA cycle
Note: Each new GOAL (1st Fundamental Question) will require a new Model for Improvement Guide
Source: Langley, G., Nolan, K., Nolan, T., Norman, C. & Provost, L. 1996, The Improvement Guide, Jossey-Bass, San Francisco, USA.
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Model for Improvement and PDSA worksheet EXAMPLE
Step 2: The Doing Part - Plan, Do, Study, Act
You will have noted your IDEAS for testing when you answered the third Fundamental Question in Step 1
You will use this sheet to test an idea.
PLAN

Describe the brainstorm idea you are planning to work on.

(Idea)

Plan the test,
including a plan for
collecting data

What exactly will you do? include what, who, when, where, predictions and data to be
collected

Idea: Using CAT4, identify active patients with an anxiety disorder with a GP mental health treatment plan who
have not had plan review completed in the past 12 months.
What: Sam will conduct a search on CAT4.
Who: Receptionist (Sam)
When: Begin 20 May
Where: at the practice in Dr Brown’s room
Prediction: 30% of the active patient population with an anxiety disorder will have GP mental health treatment
plan, however only 5% of those patients will have had a plan review completed in the past 12 months.
Data to be collected: Number of active patients with an active anxiety disorder with a GP mental health treatment
plan and the number of active patients with an anxiety disorder with a GP mental health treatment plan, but no
plan review in the past 12 months.
DO

Who is going to do what?

(Action)

Run the test on a
small scale

How will you measure the outcome of your change?

Completed 20 May – the receptionist contacted Brisbane South PHN for support with the PenCS CAT4 search and
the export function. The data search was conducted very quickly, with the receptionist being upskilled to conduct
further relevant searches.
STUDY

Does the data show a change?

(Reflection)

Analyse the results
and compare them
to your predictions

Was the plan executed successfully?
Did you encounter any problems or difficulties?

A total of 18 active patients (4%) with an anxiety disorder and a GP mental health treatment plan have had a plan
review in the past 12 months = 1% lower than predicted.
Do you need to make changes to your original plan?

(What next)

ACT
OR Did everything go well?
Based on what you
learned from the
test, plan for your
next step

Brisbane South PHN

If this idea was successful you may like to implement this change on a larger scale or try
something new
If the idea did not meet its overall goal, consider why not and identify what can be done to
improve performance
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1.

Create a PenCS Topbar prompt to ensure all patients with an anxiety disorder and GP mental health
treatment plan have a plan review completed. Review this by 31 July (in 2 months’ time) to determine if
there has been an increase in the % of patients recorded.

2.

Ensure the clinical team know how to complete GP mental health treatment plans in the medical software.

3.

Remind the whole team that this is an area of focus for the practice.

Repeat Step 2 for other ideas – What idea will you test next?
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Model for Improvement and PDSA worksheet template

Step 1: The Thinking Part - The 3 Fundamental Questions
Practice name:

Date:

Team member:
Q1. What are we trying to accomplish?

(Goal)

By answering this question, you will develop your GOAL for improvement

Q2. How will you know that a change is an improvement?

(Measure)

By answering this question, you will develop MEASURES to track the achievement of your goal.
E.g. Track baseline measurement and compare results at the end of the improvement.

3. What changes could we make that will lead to an improvement?

(List your IDEAS)

By answering this question, you will develop the IDEAS that you can test to achieve your CHANGE goal.
You may wish to BRAINSTORM ideas with members of our Practice Team.
Idea:
Idea:
Idea:
Idea:

Note: Each new GOAL (1st Fundamental Question) will require a new Model for Improvement plan.
Source: Langley, G., Nolan, K., Nolan, T., Norman, C. & Provost, L. 1996, The Improvement Guide, Jossey-Bass, San Francisco, USA.
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Model for Improvement and PDSA worksheet template

Step 2: The Doing Part - Plan, Do, Study, Act cycle
You will have noted your IDEAS for testing when you answered the third Fundamental Question in Step 1
You will use this sheet to test an idea.
PLAN

Describe the brainstorm idea you are planning to work on.

(Idea)

Plan the test,
including a plan for
collecting data.

What exactly will you do? Include what, who, when, where, predictions and data to be
collected

DO

Who is going to do what?

Run the test on a
small scale.

How will you measure the outcome of your change?

STUDY

Does the data show a change?

Analyse the results
and compare them
to your predictions.

Was the plan executed successfully?

(Action)

(Reflection)

Did you encounter any problems or difficulties?

Do you need to make changes to your original plan?

(What next)

ACT
OR Did everything go well?
Based on what you
learned from the
test, plan for your
next step.

If this idea was successful you may like to implement this change on a larger scale or
try something new.
If the idea did not meet its overall goal, consider why not and identify what can be
done to improve performance.

Repeat Step 2 for other ideas - What idea will you test next?
Brisbane South PHN
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First floor, Building 20, Garden City Office Park, 2404 Logan Road, Eight Mile Plains QLD 4113
PO Box 6435, Upper Mt Gravatt QLD 4122 T: 3864 7555 or 1300 467 265 | F: 3864 7599
bsphn.org.au | ABN 53 151 707 765
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